
PAF for Palm OS

It’s free, it’s easy, 
and it fits in your pocket
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Introduction
Imagine taking your PAF 5 database with you to the 
library or to a family gathering…in your pocket.  
That’s what you can do with the free, downloadable 
PAF for Palm program.  If you have any of the 
various Palm Operating System (Palm OS) handheld 
computers, you can easily export all or part of your 
PAF 5 database.
For a review of PAF for Palm, visit this Website:  
www.svpafug.org/handhelds.html.  For step-by-step 
help in using PAF for Palm, keep reading!
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Downloading and Installing 
PAF for Palm
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Where Do I download 
PAF for Palm?

It’s 
here

It’s not here!
The first question people have about PAF for Palm is where to find it.  
Occasionally, visitors to the PAF 5 download page at www.familysearch.org
can’t find the PAF for Palm download.  The problem is that they’re not scrolling 
down far enough.  It’s near the bottom of the page.

Once you click on the file’s Download button and download it to your computer, 
install it by double-clicking on the icon for paf.prc in your PC’s downloads area 
(typically My Download Files or an equivalent).
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PAF for Palm automatically installs itself 
in the Install Tool of your Palm OS 
desktop software.  The next time you do 
a HotSync, it will install itself 
automatically on your handheld.  You 
will get the message at right:
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Click

Now, connect your handheld to your PC 
and click on the HotSync icon (above).  On 
the HotSync screen (at right), click on the 
Local Sync icon (if you are connected by a 
cable or HotSync cradle).
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Voilà!

Once the program is installed, the 
PAF for Palm icon will show up on the 
menu  list of your handheld.
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Creating and Downloading 
a PAF for Palm Database
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Even though your program is installed, 
there is nothing yet for you to view in 
your PAF for Palm program.  You need to 
create a database to download.
Inside PAF 5, select Export from the File
pull-down menu.
Note: PAF for Palm alphabetizes all-
uppercase names separately from upper-
and-lower-case names. 
If your PAF 5 database has a mixture of 
all-uppercase surnames (e.g., JONES) 
and upper-and-lower-case surnames (e.g., 
Jones), make the surname capitalization 
consistent before you export. 
If these capitalization styles are mixed, 

go to the Tools pull-down menu, select 
Preferences, and click on the Names tab.  
Make the names consistent by clicking (or
unclicking) Capitalize surnames on 
screens and reports.  
We don’t know if this is a bug or a 
feature, but in any case, it’s a reality. 

Select
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Select All
or Partial

Select 
Choose the options you want

Choose the PAF for Palm OS
handhelds option.  Decide whether 
you want to download Notes, 
Confidential data, Full information 
on living, and LDS data.  Also, 
decide if you want to download your 
entire database or just part of it 
(All or Partial).
For most uses, you probably will 
find it easier to work with part of 
your database on a handheld, 
because handheld navigation is not 
as easy as navigation in PAF 5.  A 
large database of thousands of 
names loads and runs slowly.
You can download multiple 
databases to your handheld; the 
size of the handheld’s memory 
capacity is the primary limitation on 
the size and number of databases. 

Note:  PAF for Palm 
does not download Sources 

from PAF 5, only Notes.
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Once you’ve either chosen All or 
Partial (and, if you’ve chosen Partial, 
you’ve used the Select function to 
identify what data to download), click 
Export.
PAF 5 will then warn you (below) that 
you’ve selected a character set that 
might not include all the characters in 
your database.  Since you have no 
real option, tap Yes.
PAF then begins exporting.  When it’s 
done, it states how many individuals 
and marriages it exported. 
The next process can take a minute or 
so.  Be patient and wait for it to finish. 
Don’t click any buttons while waiting!

Select

Select
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Click

PAF automatically places 
the exported database in 
the Install Tool area on 
your PC’s Palm Desktop, 
so that the next time you 
HotSync your handheld 
and your PC, the program 
will install the database on 
your handheld.
Next, you will HotSync:

Click
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Next, tap on the PAF icon on your 
handheld.  If you have only one 
database in your handheld, this will 
open your database.
PAF automatically gives an exported 
PAF for Palm database the same name 
as the PAF 5 file from which it is 
created.  This is problematic if you want 
to create multiple handheld databases 
from the same PAF 5 file.
To create more than one small database 
from your PAF 5 database, you will need 
to use the PAF 5 ‘Save As’ feature (from 
the File pull-down menu) to make a copy 
of your PAF 5 database with a different 
name.  You can delete this copy of the 
file later; for now, give the new copy of 
the file a name that will help you identify 
the database you are creating from it.
Next, create the new PAF for Palm 
database to export to your handheld.  At 
this point, you can delete the copy of 
your PAF 5 database.

Select

Note: If you have more than one 
database downloaded to your 

handheld, PAF for Palm will open 
to a list of your databases.  You 

can then select one to open. 
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Deleting 
a PAF for Palm Database
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To delete a database on PAF for Palm, tap the 
Menu icon on your handheld and select Databases 
from the Options pull-down menu.

Tap the Delete button at the bottom of the 
Databases screen (below, left), then select the 
database you want to delete.  At the prompt 
(below, right), choose Yes if you’ve selected the 
correct database to delete.

Select
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Comparing PAF 5 
and PAF for Palm
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PAF 5

Family Pedigree Individual 
(List)

PAF for Palm is a program that runs an exported PAF database  
on a Palm Operating System handheld computer.  

Although the names, dates, places, and notes you export 
replicate those in a PAF 5 database, the structure of information 
on a Palm OS handheld doesn’t exactly replicate the PAF 5 
screens, listed here – Family View, Pedigree View, and 
Individual (List) View.
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PAF 5

Family Pedigree Individual 
(List)

Edit Individual

This is how the views of PAF 5 and PAF for Palm compare.  
The Family Views are quite similar in content.  The Individual or List views 
are somewhat similar.  
The Pedigree View in PAF 5 has a rough equivalent in the Ancestors and 
Descendants screens in PAF for Palm.  
The Individual Detail View in PAF for Palm is somewhat comparable to the 
Edit Individual screen in PAF 5.

PAF for Palm OS

Individual 
DetailFamily List

Notes Ancestors Descendants
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Navigating PAF for Palm

List View
Family View

Ancestors and Descendants screens

Individual Detail View
Notes
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These are the pathways you can follow to move between the various views and 
screens in PAF for Palm.  Most screens allow you to return to List or Family view.

List View
Tap on name

Tap on date field

Family View
Tap on name

Tap on spouse’s name

Notes icon

P (go to parents’ family)
S (choose spouse, if more 

than one spouse)

Individual Detail
Individual’s detail
Spouse’s detail

From pull-down menu:
Notes

Lifespan
Burial

Christening
LDS ordinances

‘All Info’

Notes

Ancestors

Descendants
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Click on 
date field
to go to 

the 
Individual 

Detail 
View for 

that name

List View

Click on a 
name to go to 

that 
individual’s 
Family View

This is the List View of PAF for Palm. 
Click on the NAME to get to the Family View.  Click on the DATE FIELD to get to the 
Individual Detail View.  
Click on the little circled letter i to get an Information screen with brief instructions. 
Individuals with no known surname are included at the end of List as:
– Unknown –, <first name>

You can go to names starting with a certain letter by entering that letter in the 
Graffiti (or other text entry) area of the handheld.
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Click P to see 
parents’ 

Family ViewFamily View

Click S to 
select a 
spouse 

(if >1 
spouse)

Click to see 
spouse’s 
parents’ 
Family 
View

Click to go 
to List 
View

Within the Family View, you can navigate to many other screens. Click List to go 
back to the List View.  Click on the P to see the Family View of the parents of either 
spouse.  Click on the S to select a different spouse, if an individual had more than 
one.
You also can access the Family View for any child listed at the bottom of the 
screen by clicking on that child’s name.  Clicking on the date field for the child will 
take you to the Individual Detail View for the child.
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Click down-
arrows to see 
Descendants

Click up-
arrows to see 

Ancestors

To see several generations in 
the Ancestors screen, click on 
one of the up-arrows.
To see several generations in 
the Descendancy screen, click 
on one of the down-arrows.
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This is the Ancestors Screen. To see further ancestors in 
this line,  click on the name of an ancestor who isn’t the key 
individual.  Clicking on an ancestor will bring up that 
person’s ancestors.  The display is limited to three 
generations at a time.
The little square dot by the date field indicates that the 
individual has offspring listed in this database.

Ancestors 
Screen

Key individual’s 
father

Key individual 
(3rd generation)

Key individual’s 
mother

Click 
to exit
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2nd

generation

1st

generation

3rd 
generation{

{

Also 2nd

generation

Click 
to exit

Descendants 
Screen

This is the Descendants screen.  You can extend it, as with the Ancestry 
screen, by clicking on the name of someone with offspring listed in the 
database.
Click on a 2nd or 3rd generation name with a square dot beside name to 
see more generations
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Individual Detail View

Lifespan 
option 
chosen

This is the Individual Detail 
View.  
You can select how much and 
what kind of information to 
view by using the little 
pull-down menu on the 
screen.  This is the Lifespan 
option.
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Burial 
option 
chosen

This is another option in 
the Individual Detail View.  
If an entry has burial 
information, you can select 
the Burial option from the 
pull-down menu.

This also is an option in 
the Individual Detail View.  
If an entry has christening 
information, you can 
select the Christening 
option from the pull-down 
menu.

Christening 
option 
chosen
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Notes

Notes 
option 
chosen

This is another option in the 
Individual Detail View.  
If an entry has Notes from 
PAF 5, you can select the 
Notes option from the 
pull-down menu.
The entire Note is included, 
even long Notes.
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The handheld instructions 
for saving information

Even though you can’t enter 
information into PAF for Palm, you 
can export data from to the Memo 
utility of your handheld, and then 
make notes or changes that you 
later upload to your PC.  You can 
then cut and paste or otherwise 
enter the information in to PAF 5.
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Select Export to Memo

Tap the Menu icon on your 
handheld (it usually looks like a 
little pull-down menu), and 
select Export to Memo.  Then, in 
the Memo utility, select the 
memo you’ve exported and 
make whatever notes or 
changes you want.

The next time you perform a
HotSync, this new memo will 
upload to your PC, and you can 
then copy from it or print it.
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How to Find Information
in PAF for Palm

The handheld’s Find function
Names, Places, Notes, and Dates

The Search utility in PAF for Palm
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How to Find Information in PAF for Palm

Select Preferences

You can use either of two separate 
searching utilities to find information in 
your PAF for Palm database.  One is the 
Find function, which allows you to 
search for words and numbers anywhere 
in your handheld.  The other is the 
Search feature of PAF for Palm.

The Find feature is the more powerful of 
the two. It is represented by a little 
magnifying glass icon opposite from 
your Menu icon.

To use the Find feature within PAF for 
Palm, tap the Menu icon on your 
handheld and select Preferences from 
the Options pull-down menu.
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The Preferences box allows you to 
customize the Find feature so that you 
can search through the PAF for Palm 
names, places, notes, and/or dates.  

Using Find brings up a screen listing all 
the items in your handheld that contain 
the names, places, note contents, or 
dates (years only) you enter.

This does not work with the program’s 
Search button.  It works only with the 
Find feature, which you access by 
clicking on the little magnifying glass 
icon.

Also, selecting or deselecting the 
Descendants icon checkbox 
determines whether little square bullets 
mark the names of individuals with 
descendants listed in this database.

Select which features to 
use with the Find feature 

on your handheld
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The PAF for Palm Search Utility

Within the PAF for Palm program is a 
Search utility.  Selecting the Search button 
at the bottom of some screens brings up 
this Search screen.

You can perform a name search by 
entering the surname and either the entire 
given name or the first letter of the given 
name.  The Search program looks for the 
entire surname name and matches on 
letters within the given name.  Capital 
letters are not necessary.  

We have had mixed success with this 
Search utility. Sometimes it worked well; 
other times, it did not work at all.  Your 
success with it may depend on the version 
of Palm OS software on your handheld.
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Beaming a PAF for Palm Database 
between Handhelds
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Beaming Databases between Handhelds

You can use your handheld’s beam 
function to transfer entire databases back 
and forth between handheld users.  This is 
much easier than uploading the PAF for 
Palm database to a PC, moving it to 
another PC, and downloading it to another 
handheld.

Click the Menu icon, then select Options
from the pull-down menu.  Select 
Databases.  

Select the Beam button at the bottom of 
the Databases screen, then tap on the 
name of the database you want to beam to 
another handheld.  

(Note:  One database is highlighted here 
because it is running.  You can beam any 
database, even one that is running.)

Select Beam and then select 
the database you want to 
send to another handheld
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Using Multiple Databases

Choose the Select 
button (below), then 
tap on the name of a 

database (above) 
to open it

You can load multiple PAF for 
Palm databases into your 
handheld, using the PAF 5 Export 
feature.

To access databases you have 
downloaded, select the Menu icon, 
then select Options from the pull-
down menu.  Select Databases.  

Tap on the Select button at the 
bottom of the Databases screen, 
then tap on the name of the 
database you want to open.  If a 
database is already open, its name 
will appear highlighted (darker, 
actually). 
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The screen at left will appear on 
your handheld, asking if the 
highlighted database is the one 
you want to beam to another 
handheld.

After your handheld locates 
another handheld in beaming 
range and beams the file to it, the 
messages below will appear on 
the recipient’s handheld:  

Your Handheld Screen

The Recipient’s Handheld

Select Yes if you 
have chosen the 

correct database to 
beam

If Yes is chosen 
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Some Final Tips

Copyright © 2002 Silicon Valley PAF Users Group.  All rights reserved. May be copied for incidental instructional or personal use 
only.  Commercial distribution or display is strictly prohibited.



41

If your PAF 5 database has thousands of 
names, create and export several smaller 
databases to export into PAF for Palm –
they will be easier to navigate than one 
huge file.
Be careful what software you download 
and install on your PDA.  Don’t overload 
it with games and utilities you won’t use.
Install one application at a time and 
make sure your handheld still works well 
after each new piece of software you 
load.
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One Final Tip on HotSync
If you don’t plan to read e-mail on your 
handheld, you must configure your handheld 
not to download e-mail from your PC.  
Otherwise, your handheld could fill up with 
e-mail messages that must be deleted one 
message a time.  Tedious – and annoying! 
(We speak from experience…)
To avoid this problem, open the Palm Desktop 
screen on your PC.  Select the HotSync 
pull-down menu, and then select Custom. 
Click Change on the the Mail option and then 
select Do Nothing.  Click OK on that screen, 
then click Done on the next screen.
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